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Lesson: April 13, 2020

Objective/Learning Target:
Students will become familiar with Microsoft PowerPoint and
Google Slides
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Let’s Get Started:
If you are using a computer with Microsoft Office,
click here (Go to slide 4)

If you are using a computer without Microsoft Office,
click here (Go to slide 19)




Getting Started with
Microsoft Office PowerPoint

Watch Video: Getting Started with MS PowerPoint



https://youtu.be/k6pg4nZS6fA
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What is Microsoft PowerPoint:

PowerPoint is a presentation program that allows you to create dynamic slide presentations.

These presentations can include animation, narration, images, videos, and much more. In this

lesson, you'll learn your way around the PowerPoint environment, including the Ribbon, Quick
Access Toolbar, and Backstage view.
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Practice: Opening PowerPoint for the

First Time B

When you open PowerPoint for the first PowerPoint [ a——— " |
time, the Start Screen will appear. From e o
here, you'll be able to create a new
presentation, choose a template, and Y Mongibello About Us

access your recently edited S0l e K Take a 6
presentations. From the Start Screen, tour

locate and select Blank Presentation to —— Blark Preseriation Weicome to PowerPoint
access the PowerPoint interface. M Adoptable Fets

\\psf » Home « Document...

Business  Odentation 43

Rece nt Education Blue  Personal

Today

Space Quiz

3 \'psf » Home » Document..

Make Interactive Videos

wir Fowerfort and O

@ Open Other Presentations

B Office Mix

Create an Office Mix Chalkboard education presentati..
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e All recent versions of PowerPoint include the Ribbon and the Quick Access
Toolbar, where you'll find commands to perform common tasks in PowerPoint,
as well as Backstage view.

e PowerPoint uses a tabbed Ribbon system instead of traditional menus. The
Ribbon contains multiple tabs, which you can find near the top of the
PowerPoint window.

Presentation1 - PowerPoint

Design Transitions Animations Slide Show Review View Q Tell me what you want to do...
‘.D ¥, Cut | [:I Layout ~ A A = = e=5= | 1= ‘$ Text Direction \ \
5 ER) Copy 7 ] Reset = Align Text AL L
aste ew 2he AV A3 TR T == |
- ¥ Format Painter | glide~ 0 Section~ B £ N Sk A = (=] Convert to SmartArt (2’ —\.' /\

Clipboard ¥ Slides Font Paragraph



Jospiv ﬁmﬁesﬁ

NDEPENDENCE SCHOOL DISTRIC

Each tab in Microsoft contains several groups of related commands. For example, the Font group on

the Home tab contains commands for formatting text in your document.

Mongibelio About Us - PowerPoint

Design Transitions Animations Slide Show Reviews View
C —E ut- | . v S — 1~ _ ||} Tost Direction =
= Jrayo | Corbel (Body) =122 | A A W= 1=« &38| 1= :,[,ij Text Direction
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aste aid ¢ AV . - YR =E ==
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h Convert to SmartArt ~
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Some groups also have a small arrow in the bottom-right corner that you can click for even more options.
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MS PowerPoint: Showing/Hiding the Ribbon

If you find that the Ribbon takes up too much screen
space, you can hide it. To do this, click the Ribbon
Display Options arrow in the upper-right corner of
the Ribbon, then select the desired option from the
drop-down menu:

Auto-hide Ribbon
Hide the Ribbon. Click at the top
of the spplicstion to show .

.
v
| ".‘ :Sho
A Q‘ ‘k < Sha
range Quic
Styles - {? Sha

Drawing

jm—— Show Tabs
Show Ribbon tabs only. Chck a
tab to show the commands
. Show Tabs and Commands
=== Show Ribbon tabs and

commands all the time

Auto-hide Ribbon: Auto-hide displays your
document in full-screen mode and completely
hides the Ribbon from view. To show the Ribbon,
click the Expand Ribbon command at the top of
screen.

Show Tabs: This option hides all command groups
when they're not in use, but tabs will remain
visible. To show the Ribbon, simply click a tab.
Show Tabs and Commands: This option
maximizes the Ribbon. All of the tabs and
commands will be visible. This option is selected
by default when you open PowerPoint for the first
time.
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MS Office: Using the Tell me
feature

If you're having trouble finding a command
you want, the Tell Me feature can help. It
works just like a regular search bar. Type
what you're looking for, and a list of
options will appear. You can then use the
command directly from the menu without
having to find it on the Ribbon.

Mongibello About Us - PowerPoint

Review View Q shapes
|1 75 Shapes
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E]  Insert Text Box
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MS Office: The Quick Access Toolbar

Located just above the Ribbon, the Quick Access Toolbar lets you access common commands no
matter which tab is selected. By default, it shows the Save, Undo, and Redo commands, but you can
add other commands depending on your needs.

1.  Click the drop-down arrow to the right of the Quick Access
Toolbar

2. Select the command you want to add from the menu

3. The command will be added to the Quick Access Toolbar
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MS Office Practice: Show/Hide the
Ruler

Mongibello About Us at

File Home  Insart sign  Transtions  Animations  Slide Show  Review [EISON O Tollme
" H = 1"! Shide Sorter [t“}sude Master | Raler Q q H' ] [~ = |
3 = NotesPage  [1]Handout Master ' Gridlines -
Nomnal Outline __ Notes  Zoom Fitto Color/  Window Macros
T Reading View [ -] Netes Master /! Guides Windove Grayscalev =

1. Click the View tab b B s S i 08 (S

View

Thumbnails v

2. Click the checkbox next to Ruler to show i K mIEEnN
or hide the Ruler b e e s ;

Slide3of8 L[¥ English {Untec States) = Notes Wi Comments | [B 55 B
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MS Office: Backstage View

+ Backstage view gives you various
options for saving, opening a file,
printing, and sharing your document. To
access Backstage view, click the File
tab on the Ribbon.
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E} lose
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Presentation - PowerPoint

Protect Presentation
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presentation.

Inspect Presentation
Before publishing this file, be aware
that it contains:
' Document properties and
author's name
Content that people with
disabilities are unable to read

Manage Presentation
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Properties ~
Size

Slides

Hidden slides
Title

Tags
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Created

Last Printed
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Author
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Add a category

Today, 10:14 AM

A Merce..
Add an author

Not saved yet




_Z;s i ﬁfeﬂfimﬁﬁ

NDEPENDENCE SCHOOL DISTRIC

MS Office: Zoom and View Options

PowerPoint has a variety of viewing options that change how your
presentation is displayed. You can choose to view your presentation in Normal
view, Slide Sorter view, Reading view, or Slide Show view. You can also
zoom in and out to make your presentation easier to read.
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Switching Slide Views:

Switching between different slide views is easy. Just locate and select the desired slide view
command in the bottom-right corner of the PowerPoint window.

»

= Notes Wl Comments B 55 B % |-—) : + 41% 03
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Zooming in and out

To zoom in or out, click and drag the zoom control slider in the bottom-right corner of the PowerPoint
window. You can also select the + or - commands to zoom in or out by smaller increments. The

number next to the slider displays the current zoom percentage, also called the zoom level.
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Playing the Presentation

When you are ready to show your presentation—or if you want to see what it will look like during a
presentation—click the Slide Show tab. You can make a selection from where in your presentation
you want to present.

Home Insert Design Transitions Animations Slide Show Review View Q Tell me what you want to do...

@' .[g E‘@ EE EIIZI A‘I F@ ./5 1 Play Namatians =P Monitor: | Automatic v

: ; V! Use Timings
From From Present Custom Slide SetUp  Hide Rehearse Record Slide )
Beginning Current Slide Online~  Show~  SlideShow Slide  Timings Show~ Y/ Show Media Controls

Start Slide Show Set Up Monitors

|| Use Presenter View

You can also click the From the beginning button on your quick access toolbar

® =

P

Home Insert Design




Jospiv ﬁrmﬁesﬁ

NDEPENDENCE SCHOOL DISTRIC

CHALLENGE!

w N

© N OHA

Click t@@dd title
Click to add subtitle

Open PowerPoint, and create a blank Presentation.

Change the Ribbon Display Options to Show Tabs.

Click the drop-down arrow next to the Quick Access Toolbar and add New, Quick Print,
and Spelling.

In the Tell me bar, type Shape and press Enter.

Choose a shape from the menu, and double-click somewhere on your slide.

Show the Ruler if it is not already visible.

Zoom the presentation to 120%.

When you're finished, your presentation should look something like the picture above
Change the Ribbon Display Options back to Show Tabs and Commands.



Getting Started with Google
Slides

Watch Video: Getting Started with Google Slides



https://youtu.be/1ENtPjEp_5c
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What is Google Slides:

Google Slides allows you to create dynamic slide presentations. These presentations can include
animation, narration, images, videos, and much more. In this lesson, you'll learn about the Google
Slides interface and the basics of setting up your document, including the menu and shortcut
toolbars, zoom settings, and choosing a theme.
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Practice: Opening Google Slides for the First Time

I Untitled presentation g3 o RO SANTIRGAID >
When you create a new presentation in el ::\“E e SOl me
Google Slides, the interface for Slides
will appear. This interface displays the
toolbar, along with the main view of your -
presentation. It allows you to create and Click to add title
modify slides, choose a theme, and - . _

. . Click to add subtitle
share the presentation with others.

Click to add notes [+
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When you first create a new
presentation, Google Slides will
prompt you to choose a theme.
Themes give you a quick and easy
way to change the overall design
of your presentation. Each theme
has a unique combination of
colors, fonts, and slide layouts.
Select a theme from the panel on
the right side of the window, and it
will be applied to your entire
presentation.

Table Help
H More -

add title

id subtitle

merced fores? 3@gmall com ~

Click to add title

&

Tropic

Marina

Click to add title

Import theme
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You can choose from a variety of new themes at any time, giving your entire presentation a consistent,

professional look. If you want to change your theme, you can open the Themes panel again by clicking
the Theme command on the shortcut toolbar.

merced floresT 3@gmal com -

Table Help 3 Present ~  Comments m

E Background... Layout- Theme.. Transition...

A
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e The Google Slides interface uses a traditional menu system with a shortcut
toolbar. The menus contain commands grouped by function. The shortcut
toolbar has buttons for some frequently used commands.

Untitled presentation
File Edit View Insert Slde Format Arrange Tools Table Help &

A @ Kk [T G-\ - B sackgrouna..

]

1_

Click to ¢

Click to adc
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Google Slides: Showing/Hiding the Toolbar

You can choose to minimize the menu bar to free up more space to display your slides. Click
the Hide the menus command to hide the menu bar, leaving only the shortcut toolbar at the
top of the window. Click it again to show the menu bar again.

merced flores? 3@gmal com ~

B Background... Layout- Theme.. Transition.. a

Hide the menus (Ctri+Shift+F)

ick to add title
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Google Slides: Using the Tell me

File Edit View Insert Format Slide Arrange Tools Add-ons Help Lastedit was made 4 minutes ago by Jackie Becker -
feature bebiabtdl LI R e
s : New slide Ctri+M ¢ ’ £ 2
Getting Started with
, . . . MR e Yol =] New presentation ‘t Word: e
. Ol
If you're having trouble finding a command o S
b3 New document from template
T Mir slication that allows you to create
you want, the Tell Me feature can help. It " I I pe— esumes, and more. In this lesson
= you ace and become familiar with son
H 1 H f : Ribbon, Quick A Toolb
works just like a regular search bar. Click 1| I Newspreodsheet i, e fosi
ning Word o e Fist e = E B Newform

the Help option. In the search the menus =~

- 8 New drawing

bar, type what you're looking for, and a list =) &
of options will appear.

Updates
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Google Slides Practice: Show/Hide the Ruler

File Edit View Insert Format Slide Arange Tools Add-ons Help Lastedit was made 6 minute

AR ] Present CrF5 \ ~ Background ~ Layoutv Theme | Transition

Motion  Cirl+AltsShift+B

What is Mi

1. Click the View option u T

variety of documents, including |

Zq0m! > you'll leam how to navigate the We
+ Show ruler of its most important features, suc
and B
Guides -
Snapto >

' Show speaker notes

Full screen

=3 File Edit View Insert Format Slide Amange Tools Add-ons Help Lasteditwasme

2. Click the check next to Ruler to show or hide R N S T

o Motion  CtrisAltsShift+B

the Ruler w

eridview cutAl Microsoft Word is a wor

variety of documents,
200m - you'l learn how to navige
of its most important fee

+ Show ruler

Guides .

Opaning Wordfac

snapto -
v Show speaker notes

=== Full screen
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Google Slides: Backstage View . -

File Edit View Insert Format Slide Arrange Tools Adc

» Unlike Microsoft Office, Google slides + - shae im-aN- @ e
does not have a backstage view when e .
File is selected. 1 open Ctriso
- When you click File, the drop down " s
menu gives you various options for [
saving, opening a file, printing, and povnioac "

Email as attachment

renaming your document. To access this ke b afine
menu, click the File option in the top left SRR s
corner of your document

Rename
]

3 (21 Move

Move to trash

Publish to the web

il collaborators add speaker notes

Document details
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Google Slides: Zoom and View Options

You can zoom in and out of your presentation Untited presentation

Wlth the Zoom ShOrtCUt ClICk Zoom on the File Edit View Insert Slide Format Arrange Tools Table Help
shortcut toolbar, then move the mouse cursor
over your slide. The cursor will change to a

magnifying class with a plus sign inside of it. - B
Now you can left-click to zoom in or right-click

to zoom out. Press Escape on your keyboard

to return your cursor to normal.

+me AT Fa (AT DU\ B s
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You can set the zoom more precisely in

the View menu.

Untitled presentation
File Edit View Insert Slide Format Arrange

+ | & Present 3 +Enter |
Animations 3 +Option+Shift+B

Master l

[l

+*1 Fit (68%) @
50%

100%

200% I

Zoom in #8+Option++

Zoom out & +Option+

Snap to >

HTML view 3 +Option+Shift+P
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Playing the Presentation

When you are ready to show your presentation—or if you want to see what it will look like during a
presentation—click the Present button to the right of the menus. You can also click the drop-down
arrow for additional presentation options.

merced floresT3@gmal com

Arrange Tools Table Help Al 3 Present i' Comments m

™| Q Present from beginning #+Shift«Enter ..  Transition...

Present with speaker noles



_Z;ﬁ i ﬁfeaffresﬁ

NDEPENDENCE SCHOOL DISTRIC

ok wbd -~

CHALLENGE!

Open Google Slides and create a blank presentation.

Change the presentation title from Untitled Presentation to Practice Presentation.
Choose a theme for your presentation.

Use the View menu to set the zoom to 50%.

When you're finished, your presentation should look something like this: Note: Colors and
fonts might be different.

Practice Preserzaton B
- GOl Ve bt e Famu Aige Tik Tibe e A harge e O

‘anr B
H

| e -

———

el - |
CLICK To ADD TIE -
-
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For More Resources:

Google Slides:

https://edu.gcfglobal.org/en/gooagleslides/getting-started-with-your-presentation/1/

Microsoft PowerPoint:
https://edu.gcfglobal.org/en/powerpoint2016/getting-started-with-powerpoint/1/

(%, GCFGlobal @ GCF

i y Crmabs



https://edu.gcfglobal.org/en/googleslides/getting-started-with-your-presentation/1/
https://edu.gcfglobal.org/en/powerpoint2016/getting-started-with-powerpoint/1/

